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1 About 
1.1 About this Manual 
This manual describes the components and functionality of the Hamilton Liquid 
Verification Kit (LVK) and will guide users in the correct and safe installation and operation of 
the LVK. 

Revision History: 

Version Revision Release Date Description 

01 A 12/2020 Document created 

 

All efforts have been made to ensure the accuracy of the contents of this manual. 
Hamilton Company can assume no responsibility for any errors in this manual or their 
consequences. If any errors are found, please contact Hamilton Company. 

Reproduction of any part of this manual in any form whatsoever without the express 
written consent of Hamilton Company is forbidden. The contents of this manual are subject 
to change without notice. 

Copyright© 2020 Hamilton Company. All rights reserved. 

Microlab® is a registered trademark of Hamilton Company. 

NIMBUS® is a registered trademark of Hamilton Company. 

The Microlab® STAR™, STARPLUS, STARLET, NIMBUS®, and NIMBUS HD will be referred to as 
STAR and NIMBUS for the remainder of this manual. 

For the latest revisions of Hamilton manuals, drivers, and software, contact Hamilton 
support. 

1.2 Intended Use of the LVK  
The Hamilton Liquid Verification Kit (LVK) is a tool to help users to develop or optimize 
liquid classes and verify liquid transfers on Hamilton liquid handling platforms. The LVK 
software provides an interface to design and run custom liquid handling tests and analyze the 
volumes pipetted in real time for precision and accuracy. These volumes are calculated 
gravimetrically using information entered by the user and a Mettler Toledo High-Precision 
Weigh Module.  
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1.3 Product Identification  

 

EC Declaration of Conformity 

The CE marking is the manufacturer's declaration 
that allows sale of product in the EU that the 
produce meets the requirements of the applicable 
EC directives. It is a mandatory conformity marking 
for certain products sold within the European 
Economic Area (EEA). 

In the United States, electronic device 
manufacturers need to meet similar requirements 
to obtain FCC approval. 

 

Product Certification 

The CSA C/US mark signifies that the product is 
certified for both the U.S. and Canadian markets, to 
the applicable U.S. and Canadian standards. 

 

CHINA-RoHS 

All Electronic Information Products (EIP). Extensive 
list published which includes many products not 
covered by EU RoHS such as radar attached to 
aircraft or ships, medical equipment, measurement 
instruments, some production equipment, batteries 
and most types of components. 

The number is the Environmentally Friendly (safe 
use) Period or EFUP, denoting the number of years 
before any substance is likely to leak out into the 
environment. Orange is preferred but any 
prominent color may be used. 

 

WEEE (Waste of Electrical and Electronic 
Equipment) 

This directive represents recycling, sorting and 
handling of product. The symbol for separated 
collecting of electrical and electronic equipment 
shows a crossed out bin on wheels. 
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1.4 Disposal 
1.4.1 Americas/Pacific Rim 
After the life cycle of the LVK has ended, disposal must be considered. The customer is 
responsible for proper disposal of electronic devices per local regulations. 

1.4.2 European 
WEEE Declaration 

Recycling of LVK devices is in accordance with EC directive WEEE. 

The European Community requires from manufacturers to organize the disposal and 
Waste of Electrical and Electronic Equipment (WEEE). For this reason, Hamilton Bonaduz 
AG took part in an initiative to organize the disposal of LVK products through a European 
disposal network called RENE. RENE is the largest recycling network for the disposal of 
electronic equipment in Europe.  

The mission of RENE is a European-wide, WEEE-compliant, high quality recycling for 
electrical and electronic equipment through a dense network with both innovative and 
SMB-sized partner companies. As a consequence, Hamilton Bonaduz AG gets a turn-key-
solution that includes all processes from treatment of incoming orders over collection, logistics 
and recycling down to reporting and the according management of material flows. 

Hamilton offers a WEEE process in collaboration with Toolpoint and RENE AG: 

• Request for the collection of the Hamilton instrument via Toolpoint Home Page 
(www.toolpoint.ch).  

• Completion of the decontamination confirmation form 

• Preparation for transport: packing 

• Activation of the recycling order 

• Archiving of the decontamination confirmation 

• Disposal of instrument 

Responsibilities 

Ordering Party 

Decontamination 

Preparation for transport 

 

Note: The cost for decontamination and preparation for shipment is 
paid by the ordering party. On request, Hamilton offers to take care of 
that part of the recycling process. 

http://www.toolpoint.ch/
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Responsibilities 

RENE 
Transport 

Disposal 

Toolpoint 
Registration 

Invoice the disposal to Hamilton 

Hamilton Company Organize the disposal in accordance with the WEEE directive 

 

Recycling process 

1. Request the disposal of the instrument. Access to the order registration is given by 
the Toolpoint homepage www.toolpoint.ch.  
 
 Recycling   Order registration form 

2. Complete the decontamination form. Once the form has been completed, the request 
for disposal is automatically activated and transferred to Toolpoint. The confirmation of 
the order will be sent to the registered contact person.  

3. Decontaminate the instrument. The ordering party is responsible for decontamination. 
It is mandatory to sign the decontamination form and send an electronic copy to 
Toolpoint. Toolpoint forwards the documentation to RENE, which is in charge with the 
disposal of the instrument.  

4. Pack and prepare the instrument for shipping. Instruments with a weight of over 30 
kg need to be fixed on a euro pallet. Instruments below 30 kg can be packed in a 
cardboard or plastic box. A signed copy of the decontamination form needs to be 
added to the outer part of the shipping box or instrument.  

 

http://www.toolpoint.ch/
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2 Safety 
2.1 Safety Symbols 

 

The general Warning symbol indicates the possibility of damaging the instrument or 
compromising the results of a method. 

 

The Electrical Hazard symbol indicates the presence of electrical components that 
can be harmful to the operator if handled incorrectly. 

 

The Biohazard symbol indicates the presence of biological samples that can be 
harmful to the operator if handled incorrectly. 

 

2.2 Installation  

 

WARNING: The weigh module is extremely sensitive and fragile. Use caution when 
handling and transporting it.  

 

2.3 Operation 

 

WARNING: Observe and perform the appropriate cleaning and decontamination 
procedures for any biohazardous samples. Wear appropriate PPE when handling 
the samples and the LVK’s components. Any surfaces on which liquid is spilled 
must be wiped down and decontaminated per laboratory protocols. 

 

WARNING: If the LVK crashes and is not recoverable, refer to section 8.3 to view 
the warranty. Refer to the warranty if at any time the LVK has lost accuracy. 

 
WARNING: The user is obligated to validate all methods. 

 

WARNING: Observe good laboratory practices (GLP) when using the LVK. Suitable 
protective clothing, safety glasses, and protective gloves must be worn, particularly 
when dealing with a malfunction of the instrument where the risk of contamination 
from spilled liquid exists.  
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2.4 Maintenance 

 

WARNING: Do not use cleaning or disinfecting solutions which contain hypochlorite, 
such as bleach, on the LVK. 

 

2.5 Programming 

 

WARNING: Perform test runs first with tap water and then with the final liquids prior 
to routine use. The programmer should supervise the run. 

 

WARNING: Before using any newly-created or modified methods for routine test 
purposes, they must be validated according to laboratory protocols. 

 

2.6 Electrical 

 

WARNING: For reasons of data security or integrity, use of an uninterrupted power 
supply (UPS) is recommended, since a loss of power may cause data to be lost or 
corrupted. 

 

WARNING: Only Hamilton Trained Field Service Engineers may remove a 
mechanical or electrical component in the LVK.  
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3 Device Overview 
The LVK comes with the following components:  

• Mettler Toledo WXS Weigh Module 

• Control box 

• Draft shield 

• Plate and tube adapters 

• Carrier base 

• Pedestal base 

• Hygrometer 

• Mettler Toledo display (optional) 

• Cables 

• Protective case 

The LVK also comes with the LVKUI software and a method for either the STAR or 
NIMBUS. The methods and software are discussed in greater detail in chapter 5.  

3.1 Mettler Toledo WXS Weigh Module 
The LVK uses the Mettler Toledo WXS205SDU/15 Weigh Module for precise gravimetric 
measurement of pipetted volumes. More information for this model is available on the 
Mettler Toledo website. 

https://www.mt.com/us/en/home/products/Industrial_Weighing_Solutions/AutomPrecision/High_Precision_Weigh_Modules/WX_Weigh_Modules/WXS_Weigh_Modules/WXS205SDU-15.html
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Figure 3–1: Mettler Toledo weigh module 

The pedestal for the weigh module is stored separately. It must be placed on the load cell 
prior to use. For more information on installing the balance, refer to section 4.1.  

 

Figure 3–2: Weigh module pedestals 
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3.2 Control Box 
The control box connects the weigh module to a power source and the controlling 
computer. It should be located near the LVK and out of the way of the pipetting arm.  

 

Figure 3–3: Mettler Toledo control box 

3.3 Draft Shield 
The weigh module is sensitive to environmental changes and movement in its vicinity. A 
draft shield is placed over the balance to shield it and ensure the accuracy of its 
measurements. The draft shield lid is used with the tube adapters, but left off for the plate 
adapter. 

Both parts of the draft shield are extremely fragile. Handle them with care. 
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Figure 3–4: Draft shield 

3.4 Plate and Tube Adapters 
Adapters for the dispense labware are placed on the weigh module inside the draft 
shield. The following adapters are provided:  

• Cryovial tube adapter (.5/2 mL) 

• Eppendorf tube adapter (1.5 mL) 

• Glass vial adapter (9 mL) 

• Microplate adapter 

 

Figure 3–5: Tube adapters 
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Figure 3–6: Microplate adapter 

3.5 Carrier Base 
For integration with STAR platforms, the LVK comes with an adapted seven-track 
Multiflex base. Steps for installing the LVK on the base are included in section 4.1.  

Up to two Multiflex modules can also be placed on the carrier. Make sure the modules will 
not affect the stability of the weigh module. 

 

Figure 3–7: Carrier base 

3.6 Pedestal Base 
For integration with NIMBUS platforms, the LVK comes with a pedestal base. The base 
installs on the deck pins of all NIMBUS decks, including the HD deck. Steps for installing the 
LVK on the base are included in section 4.1.  



LVK User’s Manual  

15 
 

 

Figure 3–8: NIMBUS pedestal base 

3.7 Hygrometer 
The LVK uses a Testo Hygrometer to obtain ambient temperature and humidity 
measurements. These measurements are entered manually while creating a Test Profile in the 
LVK software. 

 

Figure 3–9: Hygrometer 



LVK User’s Manual  

16 
 

3.8 Mettler Toledo Display (optional) 
The LVK can come with a display that connects directly to the weigh module. The display 
shows the weight read by the balance for additional help with calibration.  

 

Figure 3–10: Mettler Toledo display 

3.9 Cables 
The LVK comes with the following cables. Refer to section 4.1 for details on connecting 
these cables between the LVK’s components. 

• AC adapter for the control box 

• RS232 serial cable 

• LTP cable 

3.10 Protective Case 
The LVK and all of its components are stored in the case shown in Figure 3–11. When the 
LVK is not in use, it must be stored in this case to ensure the scale warranty. Detailed 
instructions on storage of the LVK are given in section 6.2. 
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Figure 3–11: LVK Protective case 
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4 Installation 
This chapter includes steps for installing the LVK and its software. Initial installation by a 
trained Hamilton service engineer is recommended, but these steps are also helpful for 
reintegrating the LVK after it has been stored. 

4.1 Hardware Installation 
The weigh module requires the following environmental conditions for safe operation:  

• Temperature: 10–30°C 

• Humidity: 20–80% rH 

Do not remove the plastic cover from the load cell until installation is complete. Place the 
control box nearby, out of the way of the instrument.  

1. Place the weigh module on the appropriate adapter for the instrument.  

• For the carrier base, place the weigh module on the pins or use the provided 
screws to attach the balance to the adapter. If using the screws, place them in 
the interior holes indicated in Figure 4–1. Make sure the cord points to the back 
of the instrument—otherwise, the load cell will not be in the correct position for 
the LVK method. 
 
Place the base on the desired tracks and slide it into place. Make sure to place 
the LVK in a position accessible by the desired pipetting device.  

 

Figure 4–1: Placing the balance on a carrier base 
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• For the pedestal base, either place the weigh module on the pins or use the 
provided screws to connect the balance to the adapter. 
 
Place the pedestal on the desired deck position. Some integration positions for 
a 9+2 deck are shown in Figure 4–2. Make sure the position of the LVK is 
updated in the deck layout file per the steps in section 4.4.1. 

 

Figure 4–2: NIMBUS 9+2 deck integration positions 

2. Connect the following cables between the balance, control box, and the controlling 
computer. Make sure the cables are routed to avoid obstructing any moving parts, 
namely the pipetting arm. 

 
WARNING: Do not connect the LVK or control box directly to the instrument. 

 

a. Connect the LTP cable from the “for connection to balance only” port on the 
control box to the balance.  

b. Connect the RS232 cable from the RS232C port on the control box to a COM 
port on the controlling computer. Using a serial-USB converter is not 
recommended. 
 
Take note of which COM port the control box is connected to, as this 
information is required for editing the LVK method. For PCs with a single serial 
port on the main board, this is usually COM1. 



LVK User’s Manual  

20 
 

 

Figure 4–3: Viewing the ports on the control box 

3. Connect the AC adapter from the Power Supply port on the control box to an AC 
outlet. Compare the control box to the one shown in Figure 4–4 before continuing. 

 

WARNING: The balance does not have a power switch—connecting the balance to 
the power supply activates the balance. 

 

 

Figure 4–4: Connecting to the control box 

4. Let the instrument sit for 60 minutes. The weigh module requires an hour to 
acclimate to the lab environment after it is connected to a power source.  

4.2 Software Installation 
4.2.1 Computer Requirements 
VENUS 2 (Vector version 4.3.5) or later must be installed before installing the LVK 
software and methods. Refer to section 8.2.3 for details on finding the software version. If 
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VENUS 2 is installed and there is adequate storage available on the computer, then the LVK 
software and methods should also install successfully. 

A PDF viewer and an Excel viewer are recommended for reviewing the results files.  

4.2.2 Running the Installer 
1. Insert the installation media. 

2. Open the installation media folder and run LVK Setup.exe. The InstallShield Wizard 
appears.  

 

Figure 4–5: Viewing the LVK welcome dialog 

3. Click the Next button. The Ready to Install the Program dialog appears. 
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Figure 4–6: Confirming installation 

4. Click the Install button to begin the installation process.  

5. A progress bar shows the status of the installation.  

 

Figure 4–7: Viewing the installation progress bar 

6. When the InstallShield Wizard is complete, click the Finish button.  
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Figure 4–8: Completing the LVKUI installation 

4.2.3 APW-Link Installation 
Mettler’s APW-Link software is useful for troubleshooting and configuring the weigh 
module. The software can be downloaded from the Mettler Toledo website. Make sure the 
weigh module is connected to the controlling computer via the control box before running the 
software. 

1. Open the installation media folder and run the installer. The APW-Link Setup Wizard 
appears.  

https://www.mt.com/us/en/home/perm-lp/product-organizations/ind/ind-oem/APW-Link-Software.html?cmp=als_apw-link


LVK User’s Manual  

24 
 

 

Figure 4–9: Viewing the APW-Link welcome dialog 

2. Click the Next button. The License Agreement dialog appears.  

 

Figure 4–10: Accepting the APW-Link License Agreement 

3. Check the box and click the Next button. The Destination Folder dialog appears. 
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Figure 4–11: Choosing where to install APW-Link files 

4. Choose where the program files will be stored. The default is C:\Program Files 
(x86)\METTLER TOLEDO\APW-Link\. To change the folder location, click the Change… 
button and select a new folder. 

5. Click the Next button. The “Ready to install APW-Link” dialog appears. 

 

Figure 4–12: Confirming installation 

6. Click the Install button to begin the installation process.  

7. When the APW-Link Setup Wizard is complete, click the Finish button. 
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Figure 4–13: Finishing the APW-Link installation 

4.3 Weigh Module Configuration 
Before the LVK can be used, the weigh module must be configured using the APW-Link 
software. This process begins immediately upon installing APW-Link. The optional Mettler 
Toledo display may also be used to configure the weigh module.  

1. When the Port Configuration dialog opens, select Receive Configuration File. Make 
sure the “Launch Wizard at startup” box is checked and click Next.  

 

Figure 4–14: Configuring the weigh module 
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2. Select COM for the connection type and Auto for the Detection Type. Click Next 
and confirm the COM port that the balance is connected to. 

 

Figure 4–15: Confirming the COM port connection 

3. For the best results, perform an internal calibration by opening the Tests and 
Calibrations tab of the wizard. Click Test and Adjustments in the Home tab, then 
select the Test and Internal radio buttons in the window that opens. Make sure the 
pedestal is on the weigh module before starting the calibration. 

 

Figure 4–16: Performing an internal calibration 

4. If volatile liquids will be used with the LVK, change the stability settings for the 
weigh module. In the Weighing tab of the Edit Settings panel, change the Environment 
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to Unstable. Click Write Settings under the Home tab to save changes to the weigh 
module. 

 

Figure 4–17: Configuring the weigh module for volatile liquids 

5. If small volumes (1-10 µL) will be tested, change the significant digits used for the 
weigh module. In the Basic tab of the Edit Settings panel, change the Readability 
setting to weigh more significant digits – “1d” means more significant figures, while 
“1/10d” means fewer. Click Write Settings under the Home tab to save changes to the 
weigh module. 

 

Figure 4–18: Changing the readability of the weigh module 

4.4 Editing the LVK Method 
The LVK method and deck layout will need to be edited depending on factors like the 
deck layout. Additional adjustments for taring and using timers are also detailed in this 
section.  
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4.4.1 Required Changes 
The default LVK deck layout and tip sequences must be edited to reflect the instrument 
that is being used with the LVK. Each instrument type (STAR, STARlet, NIMBUS, and so on) 
has its own deck layout. The default labware on deck can be changed and relocated as 
necessary.  

 

Figure 4–19: Viewing the default STAR deck layout 

 

Figure 4–20: Viewing the default NIMBUS 3x4 deck layout 

1. Open the Hamilton Method Editor. 

2. Navigate to File > Open and open the deck layout for the instrument the LVK is 
installed on. The deck layouts are located in C:\Program Files\Hamilton\Methods\LVK.  

3. Change the position of the LVK and tip carriers/pedestals as necessary. There 
should be at least one tip carrier/pedestal on the deck with adequate tips for the run. 
Make sure the tip type matches the tips on the deck. For new tip types, add labware to 
the appropriate carrier. A tip installer may need to be run to install tip definitions and 
new Liquid Classes. 
 
Keep in mind that if a 96 MPH will be used, a tip adapter must be used with the tip 
racks to pick up a single tip with channel H12. Do not place tips on the rearmost site of 
a tip carrier or the NIMBUS deck when using the 96 MPH with the LVK. 
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4. Save the deck layout when finished. 

5. Open the LVK method corresponding to the deck layout. The methods are located 
in the same folder as the deck layouts. 

6. Go to the “A_Setup_TipSequences” submethod and update the source sequences 
in the SeqCopySequence steps with the tips that were added or changed in the deck 
layout. Any steps for tip types that will not be used can be disabled. 

 

Figure 4–21: Updating the tip sequences 

4.4.2 Optional Changes 

4.4.2.1 Taring Between Measurements 
By default, the LVK method is set to zero the weigh module, dispense the liquid, and 
report the weight for each measurement. The method can be changed to zero only at the 
beginning of the method and tare between measurements instead. This change can prevent 
the method from aborting inadvertently. 

 

Figure 4–22: Viewing default commands in the LVK method 

According to the Mettler Toledo good weighing practice brochure, it is best to zero and 
then tare the weigh module between measurements. The tare must never go below the set 
zero when weighing or taring. Anything tared with a weight below the zero will produce an error 
and abort the run. The solution is to zero the scale before placing the labware adapters on the 
weigh module.  
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1. Open the main LVK method.   

2. From the Hamilton Mettler Toledo WXS category of the Toolbox, add a 
METTLER_WXS::SetZero command. Place the command between the Comment in 
line 9 and the If, Else statement beginning in line 10, as in Figure 4–23. 

 

Figure 4–23: Adding the SetZero command 

3. In the SetZero dialog, select “blnSuccess” from the “Bind return value to:” drop-
down menu and set the Value for the “i_blnZeroImmidiatly” parameter to 1.  

 

Figure 4–24: Configuring the SetZero command 
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4. Open the Zero_Balance submethod.  

5. Delete the METTLER_WXS::SetZero commands before the Tare commands in the 
submethod. The SetZero commands can also be disabled instead of deleted, as in 
Figure 4–25. 

 

Figure 4–25: Replacing Zero with Tare 

6. If the Tare commands need to be configured, input the following values:  

a. Bind return value to: blnSuccess 

b. o_fltTare: fltTare 

c. i_blnTareImmidiately: ASWGLOBAL::BOOL::TRUE 
 
Setting the Tare command to TRUE will wait until the scale reports a stable 
weight. If the environment is unstable, this setting can lead to long wait times or 
the method to abort if the timeout is reached. 
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Figure 4–26: Configuring the Tare command 

7. Save the method.  

If the method is restarted or the aborted, the tube adapter must be taken off of the scale, 
since the scale will need to be set to zero every time a method is aborted. Alternatively, after 
running the LVK method once, open the method and disable the zero command before starting 
the method again. 

4.4.2.2 Waiting before Dispensing 
Movement around the weigh module can affect its measurements due to its sensitivity. 
To ensure the highest degree of accuracy, a timer step can be added before zeroing, 
measuring, and dispensing to wait for the balance to settle after the pipetting arm stops 
moving. 

1. Open the submethod for the desired pipetting device in the LVK method. Figure 4–
29 shows the submethod for the 1000 µL channels as an example.  

2. From the General Steps category of the Toolbox, add a Timer: Start command 
before the Zero_Balance, Measure_Balance, and ReportMeasureData submethods 
are called. In the Timer dialog, select the Relative time radio button and enter 3 
seconds for the time. The default timer handle does not need to be changed.  
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Figure 4–27: Adding Timer: Start command 

3. From the General Steps category, add a Timer: Wait for command after each 
Timer: Start command. In the Timer dialog, select the respective timer handle from the 
previous step and uncheck the “Show timer display” checkbox.  

 

Figure 4–28: Adding a Timer: Wait for command 

4. Save the method.  
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Figure 4–29: Adding timers before zeroing, measuring, and reporting 

4.4.2.3 Using Vials with the 96 MPH 
Because the 96 MPH only uses channel H12 with the LVK, it is possible to dispense to a 
tube adapter. This requires moving the LVK_BALANCE_VIAL_0001 sequence so it is under 
channel H12. 

 

WARNING: Do not use the draft shield when using vials with the 96 MPH. The 96 
MPH will collide with the draft shield if using 300 µL, 50 µL, or 10 µL tips. 

 

1. Open the LVK deck layout. Click the Top View button to better see the sequences.  

2. Click the Clipping button and drag the slider until only one position is visible on 
the LVK. Select LVK_BALANCE_VIAL_0001 in the Sequences tab to verify. 
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Figure 4–30: Isolating the vial position 

3. Place a single tip in position H12 in the tip rack at position 1 of the tip carrier. 

4. Right-click the vial position and select “Adjust location…” 

5. Adjust the location of the vial position so it lines up with the H12 channel on the 96 
MPH. Select the Fixed Deck radio button in the Adjust Labware Position dialog. 

 

Figure 4–31: Adjusting the vial position 
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5 Operation 
5.1 Software Overview 
The LVK software runs the LVK method for a selected instrument to validate or develop 
Liquid Classes. The software creates and manages Test Profiles that contain settings like 
environmental values and pipetting settings, which are used to run the LVK method without 
opening Run Control or the Method Editor.  

The software uses the same user authentication set in VENUS. If users are required to log 
into VENUS, they will also be required to log in when starting the LVK software. Lab operators 
can run existing Test Profiles, but they cannot create or edit them. 

After running a Test Profile, the results are written to reports that can be reviewed later. 
These reports are saved to Documents\LVK\Results by default; the results folder can be 
changed by clicking the settings button at the top right corner. 

 

Figure 5–1: Opening LVK software settings 

 

Figure 5–2: Changing LVK software settings 
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The file directories for the Test Profile settings and log files can also be configured. 
Check the Properties Prompt box to prompt for environmental settings like temperature and 
humidity every time a Test Profile is run. 

In addition to the results folder, the contents of the results can be changed. Check the 
boxes in the Report Settings section to configure what kind of files are generated, as well as 
what data is included in these files. 

• Include graphs: Check the box to include the graphs generated in the Results tab in 
the report. 

• Include Liquid Class parameters: Check the box to include the parameters of the 
Liquid Class that was developed or verified during the run in the report. 

• Include raw weights data: Check the box to include the weights measured by the LVK 
during the run in the report. 

The COM port that the LVK is connected to must be specified in these settings before 
running a Test Profile. 

5.2 Creating and Running a Test Profile 
The LVK software uses Test Profiles in conjunction with the LVK method to validate or 
develop a Liquid Class. Test Profiles specify an instrument, pipetting settings, and whether 
the LVK method is being used for Validation or Development. Test Profiles can be saved for 
later use or editing at any point in its creation.  

If the LVK is being used for Development, make sure to create a new Liquid Class in the 
CO-RE Liquid Editor first. Choose the Liquid Class closest to the new class and save it under 
a new name.  

To get started, click Create New Test or select a preexisting Test Profile and click Load 
Selected. Existing Test Profiles can also be renamed or deleted from this screen. 
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Figure 5–3: Creating a new Test Profile 
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5.2.1 Select Instrument 

 

Figure 5–4: Selecting the instrument 

Select the instrument and pipetting device that will be used with the LVK. Make sure the 
deck, labware adapters, and deck layout file are configured to use the specified pipetting 
devices. Refer to section 4.4 for the steps required to configure the LVK method and deck 
layout to the instrument. 

Keep in mind that using the 96 MPH requires extra configuration. Only channel H12 can be 
used with the LVK, as pipetting with all 96 channels could hide inconsistencies in an overall 
average. Using the 96 MPH with the LVK will limit the number of dispenses to a total of five if 
clean tips are used each time, since the tip sequences are only defined across one tip carrier.  

Note that the Test Profile can be saved at any time using the Save Settings button in the 
top left corner. The Run Mode can be switched between Validation and Development at any 
time before running the test. If any changes have not been saved to the Test Profile, an asterisk 
will appear next to “Liquid Verification Kit” at the top of the window. 

 

Figure 5–5: Verifying unsaved changes 
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Click Liquid Class or the Next button to continue. 

5.2.2 Liquid Class 

 

Figure 5–6: Selecting the Liquid Class 

1. Select the channels used to pipette in the method. In Validation mode, all channels 
of interest should be selected. Fewer channels can be used for Development mode. If 
the 96 MPH was selected, the Channels selection will be disabled. 

2. Select the type of vial being used with the LVK. 

3. Select the tip size and type. These selections will affect the available liquid classes for 
both Validation and Development modes. Make sure the selected tips match those 
used for the method. 

4. Select the liquid type and class. For both Development and Validation mode, select 
the liquid type closest to that used in the method if an exact match is not available. The 
Liquid Class will depend on the dispense mode.  

5. Enter liquid and environmental properties at the bottom of the screen. An exact 
density is necessary to calculate accurate volumes based on the weigh module’s 
measurements. The density will not automatically update based on the selected liquid, 
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so make sure to update it before proceeding. When possible, verify the density using a 
positive displacement pipette or syringe. 
 
Use the hygrometer to obtain values for the temperature and humidity; these values do 
not affect any measurements, but are necessary for documentation. 

Click Pipetting Settings or the Next button to continue.  

5.2.3 Pipetting Settings 

 

Figure 5–7: Entering pipetting settings 

1. Define the Pipetting Cycle properties and the number of loops. This tab is the only 
one that is different depending on which Run Mode is selected. Validation mode 
requires a set number of loops, while Development mode will repeat until the user ends 
the run. 
 
If an empty dispense mode was selected in the Liquid Class section, only a dispense 
volume is required. If a part dispense mode was selected, the repetitions for the 
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dispense must then be specified, in addition to volumes and repetitions for the Pre- and 
Post-Dispense.  

 

Figure 5–8: Entering a test volume in Development Mode 

2. Define the Tip Handling for the Test Profile: 

• Keep tips: Reuse tips for each pipetting cycle and eject them to waste after the run. 

• Keep tips, return to pick-up position: Reuse tips for each pipetting cycle and return 
them to the tip rack after the run. 

• Eject tips: Eject tips to waste after each pipetting cycle and pick up new tips for the 
next cycle. 

• Eject tips, return to pick-up position: Return tips to the tip rack after each cycle and 
pick up new tips for the next cycle. 

• Eject tips, re-use tips for all cycles: Return tips to the tip rack after each cycle, then 
pick up the same tips for the next cycle. 

3. Define the Pipetting Settings for the Test Profile. These settings are the same as 
those available in the Method Editor, so they are summarized briefly here. If a jet 
dispense mode was selected in the Liquid Class section, all dispense settings but Fixed 
Height will be disabled. 

• Liquid Level Detection: Use either capacitive or pressure sensors to detect the liquid 
level and pipette a specified distance below it. Only cLLD is available for surface 
dispense. 

• ADC: Use Anti-Droplet Control when pipetting volatile liquids.  

• Submerge:  Specify a depth below the liquid level to pipette. This option is only 
available if LLD is enabled.  

• Fixed Height: Specify a height above the container bottom to pipette. This option is 
only available if LLD is disabled.  

• Mix: Set the volume and number of cycles for mixing. Mixing using half of the total 
pipetted volume is the recommended practice. The mixing submerge depth is 
measured from the dispense Submerge depth or Fixed Height.  

4. Set the Acceptance Criteria. CV% refers to the consistency of the pipetted volumes, 
whereas R% refers to the accuracy of the pipetted volumes. The following equations 
are used to calculate CV% and R%: 
 
SD : standard deviation 
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VM : mean volume 
VT : nominal volume 

𝐶𝐶𝐶𝐶% = 100 ×
𝑆𝑆𝐷𝐷
𝑚𝑚𝑚𝑚𝑚𝑚𝑚𝑚

 

𝑅𝑅% = 100 × �
𝑉𝑉𝑀𝑀 − 𝑉𝑉𝑇𝑇
𝑉𝑉𝑇𝑇

� 

5. Click START to begin the test. 

5.2.4 Results 

 

Figure 5–9: Viewing pipetting results 

The Results section has several viewing options. Under the Settings Profile field are two 
buttons to switch between a graph and table that show the progress of the test in real time. 
The data for different channels can be enabled or disabled using the checkboxes underneath 
the view buttons.  

Click the Detach button at the bottom right corner of the graph to open it in a separate 
window. Close the window to return the graph to the LVK software. The graph line style can be 
changed using the drop-down menu at the bottom of the graph. Use the zoom in/out buttons 
at the bottom left to adjust the scale of the axes; return to the default view by clicking the reset 
button. 
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Click the Help link to view additional controls for the graph view. 

 

Figure 5–10: Graph controls 

The table calculates values like CV% and R% and shows the status of each channel in 
real time. The Acceptance Criteria and Run Status can be viewed at the top right corner. The 
View Test Settings link opens a window with a summary of the settings associated with the 
Test Profile. 

 

Figure 5–11: Test Profile settings 

Once a Validation test is finished, the results of the test are shown in a table below the 
graph. A report will be saved to the folder specified in the Report Settings; refer to section 5.2 
for details. The Liquid Class Editor can be opened from this section to make changes to a 
liquid class; this option is only available after a run when in Validation mode. 
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6 Maintenance 
When the LVK is not actively being used, it should be stored in its case with its 
components. Because it is not permanently located on the instrument deck, the LVK does not 
require daily or weekly maintenance beyond routine cleaning or decontamination if spillage 
occurs.  

Half-yearly calibration of the weigh module must be performed by certified Mettler 
Toledo service engineers. If there is no certified engineer on site, the balance must be sent 
either to Mettler Toledo or to Hamilton Company. Contact a local Hamilton representative for 
details. 

6.1 Daily Maintenance 
Clean the weigh module daily after system shutdown. Remove the weigh pedestal and 
clean it and the load cell with a damp cloth. The weigh module itself can be cleaned either with 
a damp cloth or a mild household cleaner. Make sure to place the plastic cover on the load cell 
before cleaning the weigh module.  

Clean all used labware in accordance with standard procedures. 

6.2 Storing the LVK 
When not in use, the LVK must be stored in the protective case it shipped in. After 
disassembling the LVK, place all components in their designated places as they were shipped. 
Some components require extra care when packing them for storage: 

1. Power off and disconnect the LVK. 

2. Place the white plastic cap on the weigh module’s load cell and place the weigh 
module upside down in the protective case. The weigh module and load cell are 
fragile, so take extra care when storing them. 

 
WARNING: Do not store the LVK without placing the plastic cap on the load cell. 

 

3. Place the top of the draft shield in the case first, then store the rest upside down.  

4. Do not jostle the protective case during transport. The more sensitive components 
of the weigh module could be damaged if the protective case is mishandled. Store the 
LVK near the instrument to minimize transport. 

Store the LVK in a location with an ambient temperature of 10–30°C. The weigh module 
cannot be stored in temperatures outside of this range. 
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6.3 Unpacking the LVK from Storage 
1. Remove the LVK components from the protective case.  

2. Place the weigh module on the appropriate base. Refer to section 4.1 for details.  

3. Connect the weigh module and control box. Let the weigh module acclimate to 
ambient temperature and humidity for an hour before use. 

4. Make sure the deck layout and COM port used in the LVK method are accurate. 
Refer to section 4.4.1 for help with editing the LVK method.  
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7 Troubleshooting 
This section describes possible solutions for errors that can occur during routine use of 
the LVK. If the solutions presented in this section do not resolve the errors, contact a local 
Hamilton representative for assistance.  

7.1 96 MPH Tip Pickup Error 
The LVK method sometimes encounters errors when using the 96 MPH, since only one 
channel can be used. The sequence copy command for the tips can cause the method to 
abort when the tip pickup command for the 96 MPH is executed. 

Solution 

1. Open the main method in the Method Editor.   

2. Expand the If, Else conditionals and disable the EditTips_Head submethod call. 

 

Figure 7–1: Disabling the EditTips_Head submethod call 

3. Open the Pipette_96Head submethod.  

4. Disable the If, Else statement containing the EditTips_Head submethod call.  
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Figure 7–2: Disabling EditTips submethod calls 

5. Edit the tip pick-up sequence in the CO-RE 96 Head Tip Pick Up step to reference 
the tip type being used. Change the sequence counting to manually. 

 

Figure 7–3: Editing the tip pick-up sequence 

6. Expand the If, Else statements and disable the EjectTips_96 submethod call. 

7. From the ML_STAR category of the Toolbox, add a CO-RE 96 Head Tip Eject step. 
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Figure 7–4: Adding a tip eject singe step 

7.2 Init Balance Error 
This error can indicate damage to the scale, but it can be caused by less serious issues 
as well. Try the following solutions before contacting Hamilton for support. 

Solution 1 Let the scale acclimatize to room temperature and humidity 
and try again. 

Solution 2 Remove labware and adapters, then power cycle. 

 

Solution 1 

This error can occur if the weigh module is not fully acclimated to the ambient 
temperature and humidity. The weigh module must sit for an hour after it is connected to 
power before the LVK can be used. Make sure the operating conditions match those in section 
4.1, and wait for an hour before initializing the LVK again. 

Solution 2 

Turning on the LVK with any labware, adapters, or other materials on the load cell can 
cause this error to appear. Remove any materials from the load cell, then power cycle the 
scale. 
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8 Appendices 
8.1 Technical Specifications 
Refer to the Mettler Toledo website for the technical specifications of the weigh module. 

8.2 Getting Technical Assistance 
If additional assistance with the LVK is required, contact an authorized Hamilton 
Company distributor or Hamilton Company directly. Regional contact information is 
provided in sections 8.2.1 and 8.2.2. Have the following information available when requesting 
technical assistance: 

• Instrument model number 

• Instrument serial number 

• Description of the problem 

• Laboratory contact information 

If possible, supply the following additional information: 

• What was happening at the time of the error 

• What has been tried so far to solve the problem  

• Version of software (see section 8.2.3)  

• Screenshots of any errors (see section 8.2.6) 

• Photos that could more readily illustrate the problem 

• Traces and log files (see section 8.2.5) 

8.2.1 Technical Support in the Americas and Pacific Rim 
Hamilton Company 

4970 Energy Way, Reno, Nevada 89502, USA 

Toll Free (USA and Canada), General: 800-648-5950 

Toll Free (USA and Canada), Service Hotline: 800-527-5269 

Telephone: +1-775-858-3000 

Fax: +1-775-856-7259 

E-Mail: tech@hamiltoncompany.com  

https://www.mt.com/us/en/home/products/Industrial_Weighing_Solutions/AutomPrecision/High_Precision_Weigh_Modules/WX_Weigh_Modules/WXS_Weigh_Modules/WXS205SDU-15.html
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8.2.2 Technical Support in Europe, Asia, and Africa 
Hamilton Bonaduz AG 

CH-7402, P.O. Box 26, Bonaduz, Switzerland 

Telephone: +41 81 660 60 60 

Fax: +41 81 660 60 70 

E-Mail: itechsupport@hamiltoncompany.com 

8.2.3 Mettler Technical Support 
Some issues with the Mettler balance will require direct support from Mettler Toledo: 

Mettler-Toledo, LLC 

1900 Polaris Parkway 

Columbus, OH 43240 

800-638-8537 

8.2.4 Finding the Software Version 
To find the software version, navigate to Windows START > Hamilton > Version info. 

 

Figure 8–1: Locating the software version 

8.2.5 Sending Trace Files 
1. Navigate to C:\Program Files\Hamilton\LogFiles for the method traces. The 

Hamilton folder may also be located under C:\Program Files (x86). 

2. Navigate to Documents\LVK\Logs for the LVK software traces. 

3. Attach or copy/paste the relevant comm trace files to an email and send it to Hamilton. 
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8.2.6 Taking a Screenshot 
If an error appears on the screen, follow these instructions to take a screenshot: 

1. Click the desired window or error dialog. 

2. On the keyboard, press Alt+PrtScrn. This will copy a picture of the window. To take a 
screenshot of the visible desktop, use Ctrl+PrtScrn. 

3. Paste the screenshot into a Word document or WordPad. Save the document. 

8.3 Warranty 
Hamilton Company warrants this product to be free of defects in material and 
workmanship for a period of 12 months from the date of delivery. This warranty is 
extended to the buyer of record on the original purchase order to Hamilton Company. 

Hamilton Company or an authorized Hamilton representative will repair or replace, at its 
option and free of charge to the buyer at a normal place of business or at a Hamilton 
repair facility, any part or parts that, under proper and normal use, prove to be defective 
during the warranty period.* Abuse, unauthorized replacement of parts, modifications, or 
adjustments made by anyone other than Hamilton Company or an assigned representative 
voids this warranty. 

This warranty gives the owner specific rights. No other warranties, expressed or otherwise, 
including implications of warranties of merchantability and fitness for a particular product, are 
made. 

This warranty does not apply if: 

• The product has not been operated in accordance with the user manual 

• The product is not regularly and correctly maintained 

• The product is not maintained, repaired, or modified by a Hamilton authorized 
representative 

• Parts other than original Hamilton parts are used 

• The product and parts thereof have been altered without written authorization from 
Hamilton 

• The product is not returned properly packaged and secured Hamilton Company’s 
liability on the sale of all products shall be limited to repair, replacement, or refund of 
price of any defective product. 

Hamilton Company endeavors to provide prompt and satisfactory service. 

*Hamilton Company reserves the right to refuse to accept the return of any instrument or valve 
that has been used with radioactive, microbiological, or any other material or substance that 
may be deemed hazardous to employees of Hamilton Company. 
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8.4 Regulatory 
The declaration of compliance of the CE and CSA is part of the delivery of the LVK. It 
verifies that the device meets all required Directive standards. 
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